Conversion Guide for SAP S/4HANA 1610
Document History

The following table provides an overview of the most important document changes.

Table 1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>2017-05-04</td>
<td>Minor correction</td>
</tr>
<tr>
<td>1.1</td>
<td>2017-02-09</td>
<td>Minor correction</td>
</tr>
<tr>
<td>1.1</td>
<td>2016-12-08</td>
<td>Addition of SAP Notes 2389794 and 2389807. Minor structural changes.</td>
</tr>
<tr>
<td>1.0</td>
<td>2016-11-07</td>
<td>Minor correction</td>
</tr>
<tr>
<td>1.0</td>
<td>2016-10-31</td>
<td>First published version</td>
</tr>
</tbody>
</table>
# Content

1. **Conversion Guide for SAP S/4HANA** .............................................. 5
2. **Getting Started** ................................................................................. 6
   2.1 Documentation and SAP Notes for the Conversion ............................. 6
   2.2 Overview of the Conversion Process .................................................. 8
   2.3 Conversion in a Distributed System Landscape .................................. 11
3. **Preparing the Conversion** ............................................................... 12
   3.1 System Requirements ....................................................................... 13
   3.2 What’s the Impact on Your System Landscape? ................................. 14
   3.3 Supported Start Releases .................................................................. 15
   3.4 Data Volume Reduction ..................................................................... 15
   3.5 Maintenance Planner ........................................................................ 16
   3.6 Pre-Checks ....................................................................................... 17
   3.7 Custom Code Migration ..................................................................... 19
   3.8 Cross-Application Preparations .......................................................... 19
      Prepare the Use of the Maintenance Planner ......................................... 20
      Remove Client 066 ............................................................................... 20
      Uninstall SAP Fiori Apps .................................................................. 21
   3.9 List of Application-Specific Preparations .......................................... 21
4. **Realizing the Conversion** ................................................................. 23
   4.1 Conversion Using SUM ..................................................................... 23
   4.2 Cross-Application Follow-On Activities ............................................ 24
      Adapting Database Extensions to SAP S/4HANA .................................. 24
      Adapting the User Interface .................................................................. 25
      Output Management ............................................................................... 25
   4.3 List of Application-Specific Follow-On Activities ................................ 27
SAP S/4HANA is the next-generation business suite. It is fully built on the most advanced in-memory platform existing today: SAP HANA. The product uses modern design principles with the SAP Fiori user experience (UX) as well as a new role-based user experience concept. With the move to SAP S/4HANA, you are benefitting from continuous application innovations such as:

- **Application optimizations specific for SAP HANA in-memory platform**
  With SAP S/4HANA, SAP optimizes the application to make best use of the capabilities of the SAP HANA database. For example, we removed aggregates, and reduced the data footprint.

- **Responsive user experience design**
  With SAP S/4HANA, SAP designs the application with the latest role-based user experience (UX).

- **Unifying functionality in the core**
  With SAP S/4HANA, SAP removes redundancy by providing one functionality for one objective.

With SAP S/4HANA, SAP helps businesses to run simple in the digital economy, including such topics and principles as the Internet of Things, Big Data, business networks, and mobile-first.

This guide explain the conversion process with which you can move from your existing SAP Business Suite to the next-generation business suite: SAP S/4HANA.
2 Getting Started

Read this guide carefully to get an overview of how to convert an existing SAP Business Suite system to SAP S/4HANA 1610.

This guide has to be used together with the following documents:

- Simplification List for SAP S/4HANA 1610
- System Conversion to SAP S/4HANA using SUM 1.0 SP 18 (incl. DMO)
- Maintenance Planner User Guide

You find more information about these documents and guides (including where to find them), as well as additional important documents and SAP Notes relevant for the conversion in the section Documentation and SAP Notes for the Conversion [page 6].

The section Overview of the Conversion Process [page 8] provides information about the different phases of the conversion and the tools involved.

The section Preparing the Conversion [page 12] and Realizing the Conversion [page 23] provide details for those conversion phases.

2.1 Documentation and SAP Notes for the Conversion

Required Documents and SAP Notes

You require at least the following documents and SAP Notes.

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplification List for SAP S/4HANA 1610</td>
<td>help.sap.com/s4hana_op_1610</td>
<td>Lists the simplifications in comparison to the SAP Business Suite product family such as, simplified functions, merged database tables, and new data models.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Additional Information</a></td>
<td></td>
</tr>
<tr>
<td>Simplification List for SAP S/4HANA</td>
<td>SAP Note 2313884</td>
<td>Contains additional important information about simplifications.</td>
</tr>
<tr>
<td>System Conversion to SAP S/4HANA using SUM 1.0 SP 18 (incl. DMO)</td>
<td>support.sap.com/sitoolset <a href="#">Software Logistics Toolset (SL Toolset) System Maintenance</a></td>
<td>Describes how to prepare the system for running the Software Update Manager, how to use it, and what general follow-up steps are required.</td>
</tr>
<tr>
<td>Maintenance Planner User Guide</td>
<td>help.sap.com/maintenanceplanner</td>
<td>Describes how to use the Maintenance Planner for calculating and downloading the required stack.xml file and software packages.</td>
</tr>
</tbody>
</table>
### Additional Information and SAP Notes

The following table lists important additional documents and SAP Notes.

#### Table 3

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Code Migration</td>
<td>SAP Help Portal at help.sap.com/s4hana_op_1610 [1], SAP NetWeaver for SAP S/4HANA: Function-Oriented View &gt; Application Server &gt; Application Server ABAP &gt; Application Development on AS ABAP &gt; Customer-specific ABAP Development &gt; Custom Code Migration</td>
<td>Describes how you can check your custom code for required adaptations</td>
</tr>
<tr>
<td>System Conversion to SAP S/4HANA</td>
<td>System Conversion to SAP S/4HANA [1]</td>
<td>Information about the system conversion on SCN.</td>
</tr>
<tr>
<td>SAP S/4HANA: Always-Off Business Functions</td>
<td>SAP Note 2240359 [1]</td>
<td></td>
</tr>
<tr>
<td>SAP S/4HANA: Always-On Business Functions</td>
<td>SAP Note 2240360 [1]</td>
<td></td>
</tr>
<tr>
<td>Uninstalling ABAP Add-ons</td>
<td>SAP Note 2011192 [1]</td>
<td></td>
</tr>
<tr>
<td>Data Migration of Financials in SAP S/4HANA: Do not migrate twice!</td>
<td>SAP Note 2294486 [1]</td>
<td>Relevant if you are planning to convert a SAP Simple Finance, respectively SAP</td>
</tr>
</tbody>
</table>
2.2 Overview of the Conversion Process

SAP provides a process for the conversion to SAP S/4HANA. The following figure gives an overview of the tools, the phases, and the activities involved in the process.

**Recommendation**

We recommend that you do the activities in the sequence shown in the figure and explained in the sections below.

![Figure 1: SAP S/4HANA System Conversion: Sequence](image)

Prepare Phase

Simplification List

To enable you to do an optimal planning of your path to SAP S/4HANA, we provide the **Simplification List** for SAP S/4HANA 1610. The **Simplification List** is the complete collection of simplification items. It provides the key information by application or functional area about the simplifications in SAP S/4HANA. Each simplification item details the steps that need to be taken for the conversion from a business and a technical point of view, both preparatory and follow-on steps and each item is available as a SAP Note that may contain additional information.
You find the Simplification List at help.sap.com/s4hana_op_1610. See also SAP Note 2313884, to which the Simplification List is also attached (as both an Excel list and as a PDF that contains the text of the simplification item SAP Notes).

Note
You should read the Simplification List to get an overview of all the simplification items that are relevant for your specific conversion. When you have identified the simplification items relevant for your conversion, you also need to look at the relevant simplification SAP Notes themselves to get all the available information. The SAP Notes may contain more information than the Simplification List, because they may have attachments and may reference other SAP Notes. This situation is not reflected in the text of the Simplification List PDF, which is only an extract from the SAP Notes.

The simplification items are partly integrated with the pre-check and custom code migration tools. These tools provide a detailed report about where the code of your SAP Business Suite system does not comply with the scope and data structures of SAP S/4HANA. However, currently the pre-check and custom code check tool do not cover all the simplification items so that you need to review the Simplification List carefully at the beginning of your conversion project to get an overview of all required tasks.

Recommendation
We recommend that you do a test conversion in a dedicated system in a distributed system landscape to get the results of the checks early on in your conversion project.

Before starting the realization phase of the conversion process, you also have to do the following preparatory activities:

1. System Requirements
   You need to be aware of system requirements, start releases, conversion paths, and data volume. See the following sections for more information:
   - System Requirements
   - What’s the Impact on Your System Landscape?
   - Supported Start Releases
   - Data Volume Reduction

2. Maintenance Planner
   You need to run the maintenance planner tool as a first step in the conversion process. It checks your components, add-ons, and business functions to ensure compatibility with SAP S/4HANA and also creates the stack file used for the actual conversion process (done by the Software Update Manager tool). For more information, see Maintenance Planner.

Note
This step is mandatory, because the Software Update Manager requires the stack file for the conversion process.

The Maintenance Planner has replaced the Maintenance Optimizer, which is not supported by SAP S/4HANA.

3. Pre-Checks
   These checks identify important steps you need to take to make sure that your system can technically be converted and that your business processes can start running directly after the conversion process has been...
completed. There are also pre-checks available for the preparation of the migration of financial data. For more information, see Pre-Checks [page 17].

**Note**

This step is also mandatory and will be triggered again by the Software Update Manager. Ideally, you perform the pre-checks based on the stack file so that you can take note of the planning information provided by the pre-checks early in the process.

4. **Custom Code Migration**

The custom code migration tool checks your custom code against a list of simplifications developed for SAP S/4HANA. For more information, see Custom Code Migration [page 19].

**Note**

While not mandatory, this step is highly recommended. Ideally, you combine the SAP S/4HANA conversion project with housekeeping activities for your existing custom code base. In particular, you need a consolidated view of productively used custom developments and you should remove custom code that is no longer used.

We recommend that you do the steps 2 to 4 in the prepare phase in the sequence listed above. It is, however, technically possible to do them independently or in parallel.

5. **Cross-application preparation activities**

In addition to the general preparation steps described above, you also need to do some cross-application preparations. For more information, see Cross-Application Preparations [page 19].

6. **Application-specific preparation activities**

In addition to the cross-application preparations, you may also need to do some application-specific preparatory steps. These steps and their documentation are partly provided by the pre-checks and the custom code checks.

For a complete overview of all necessary steps, see the Simplification List (mentioned above). For an overview of some important preparations steps, see List of Application-Specific Preparations [page 21].

For more information about preparations for the conversion of Financial Accounting, see SAP Note 2332030.

### Realize Phase

After you have done the steps of the prepare phase, you continue with the activities of the realize phase:

1. **Software Update Manager (SUM)**

   When you have completed the steps above, and have implemented all the adaptations required to ensure your system and your custom code is suited to SAP S/4HANA, you then run the SUM. The SUM does the database migration (if required), the actual software update, and the data conversion.

   For more information, see Realizing the Conversion [page 23].

2. **Cross-application follow-on activities**

   Other manual cross-application activities may also be required. For more information, see Cross-Application Follow-On Activities [page 24].

3. **Application-specific follow-on activities**
In addition to the cross-application follow-on activities, you may also need to do application-specific manual steps. These steps and their documentation are provided by the pre-checks and the custom code checks, which provide the list of simplification items relevant for your specific systems.

For a complete overview of all necessary steps, see the *Simplification List* (mentioned above). For an overview of some important follow-on steps, see *List of Application-Specific Follow-On Activities* [page 27].

For more information about the migration of Finance Data, see SAP Note 2332030.

### 2.3 Conversion in a Distributed System Landscape

When planning your conversion project, you should use a distributed system landscape as shown in the figure below. The figure is an example of a very simple version of a distributed system landscape comprising only development and productive systems to illustrate the principle.

The figure shows that there is a development system (DEV) used to apply updates and patches to the productive system (PROD), which, at the beginning of the conversion project (t1), is a SAP Business Suite system. You then set up a second development system (DEV 2) as a system copy of the original DEV system. You use the second development system to perform and test all phases of the conversion. You can collect all the necessary software changes during the test conversion in transport requests, including those that can only be done after a conversion (for example, the Finance customizing). Note that DEV t1 and DEV t2 as shown in the figure describe the same system, at points in time before (t1) and after (t2) the conversion. The collected transports with the required software changes are then handed over to the Software Update Manager (SUM) tool and applied during the real conversion of the productive system. Note that PROD t1 and PROD t2 as shown in the figure also describe the same productive system before (t1) and after (t2) the conversion.

The use of a distributed system landscape for your conversion allows you to take as long as needed to identify and process the software changes required by the conversion and then apply these changes efficiently during the conversion of your productive system to minimize downtime.
Preparing the Conversion

For the conversion to SAP S/4HANA you have to prepare an overall project plan and schedule the tasks. The preparation activities described in this section give you an idea of what is involved. For a short overview of the process, see Overview of the Conversion Process [page 8].

**Note**
In addition, review the planning section of the Software Update Manager guide System Conversion to SAP S/4HANA using SUM 1.0 SP 18 (incl. DMO) at support.sap.com/sitoolset Software Logistics Toolset (SL Toolset) System Maintenance.

**Note**
You find the cross-application preparation steps in this guide; you get the application-specific preparation steps with the pre-check and custom-code checks and with the Simplification List for SAP S/4HANA 1610. Some of the most important application-specific preparation steps are also listed in this section: List of Application-Specific Preparations [page 21].
Please see also SAP Note 2389794.
3.1 System Requirements

Unicode

As a prerequisite for the conversion, your system needs to be a Unicode system. If your system is still non-Unicode, you can follow a two-step conversion approach: First, perform a combined upgrade and Unicode conversion with one of the supported start releases as target, then perform the conversion to SAP S/4HANA 1610.

For additional information, see Unicode Conversion Overview (on SAP SCN).

Application Server ABAP Only

Your system has to be an AS ABAP-only system. Dual-stack systems (AS ABAP and AS Java combined in one system) are not supported for the conversion. If your system is as dual-stack system, you have to split it before doing the conversion.

For additional information on how to perform a dual-stack split, see:

- SAP Note 1686144
- SAP Note 1655335
- Dual Stack Split

CDS Views (Core Data Services)

If you need to adapt your custom code during the conversion of your development system, you may need to create or edit CDS view. For example, to reflect your specific table appends in related CDS compatibility views. To find out whether these activities are required in your case, check the results of the corresponding pre-checks and the S/4HANA-specific code inspector checks.

For additional information, see:

- Pre-Checks [page 17]
- Custom Code Migration [page 19]
- Configuring the ABAP Back-end for ABAP Development Tools
- CDS - Core Data Services (on SAP SCN)
- scn.sap.com/community/abap/eclipse
3.2 What's the Impact on Your System Landscape?

When you convert your system to SAP S/4HANA 1610, you may have to adapt further systems or components in your system landscape.

SAP Enterprise Resource Planning (SAP ERP) Java Components

SAP ERP Java components are obsolete with SAP S/4HANA. You have to remove the technical Java system from the respective productive system in the Landscape Management Database (LMDB).

SAP NetWeaver

SAP NetWeaver 7.51 for SAP S/4HANA 1610

SAP S/4HANA 1610 requires SAP NetWeaver 7.51 for SAP S/4HANA 1610.

For additional information about SAP NetWeaver 7.51 for SAP S/4HANA 1610, see:

- SAP Help Portal at help.sap.com/s4hana_op_1610
- Information about the upgrade to SAP NetWeaver 7.51 for SAP S/4HANA 1610 in SAP Note 2350408
- Minimal database system platform requirements for SAP NetWeaver 7.51 in SAP Note 2329005

SAP NetWeaver Java Instances

The following SAP NetWeaver Java instances are relevant for SAP S/4HANA 1610:

- Adobe Document Services
- Enterprise Services Repository
- Advanced Adapter Engine Extended

These instances need to run on SAP NetWeaver 7.3 EHP1 (or higher).

Enterprise Services Repository (ESR) Content: You have to apply the ESR content XI CONTENT S4CORE 101.

SAP Fiori Front-End Server

SAP S/4HANA 1610 requires SAP NetWeaver 7.51 as front-end server.

You can use an existing front-end server (hub) for the SAP Fiori for SAP S/4HANA 1610 installation. Existing apps continue to run against the old back-end systems while the newly installed applications of SAP Fiori for S/4HANA 1610 need to be configured to run against the SAP S/4HANA 1610 system. As a prerequisite, you have to migrate the database of the central hub system (supported databases are SAP HANA, SAP MaxDB, or SAP ASE) and upgrade the system.

For more information, see the section Using an Existing Front-End Server (Hub Deployment) of the SAP S/4HANA 1610 UI Technology Guide available on SAP Help Portal at help.sap.com/s4hana_op_1610.

You can also run the SAP Fiori server as an add-on to the SAP S/4HANA 1610 server.

For additional information about installing the SAP Fiori server, see the SAP Help Portal at help.sap.com/fiori_implementation.
3.3 Supported Start Releases

For a one-step conversion, your system needs to have a minimum release level. The following start releases are supported:

- SAP ERP 6.0, EHP 0-8
- SAP Business Suite powered by SAP HANA
- SAP Simple Finance Add-On 1.0 for SAP Business Suite powered by SAP HANA
- SAP Simple Finance, on-premise edition 1503
- SAP S/4HANA Finance 1605

Not all start releases may initially be supported, see SAP Note 2277083 for more information. Also check the SAP S/4HANA 1610: Release Information Note 2346431 for the required feature package stack equivalencies.

3.4 Data Volume Reduction

SAP Data Volume Management is designed to reduce the data footprint so that you can achieve a shorter conversion duration due to reduced load size. Data Volume Management (DVM) offers various capabilities supporting the pre- and post-conversion phases. One central tool is the SAP DVM Work Center (DVM WoC) in SAP Solution Manager, including tools with a special focus on SAP HANA.

- Guided Self Service: You can generate a best practice document to determine data that can be reduced most efficiently in an SAP system before the conversion. You can use the same tool after the conversion to develop a blueprint for a DVM strategy.
- Reorganization and Compression: You can use this tool without a SAP HANA context in order to simulate the savings gained by reorganizing tables or databases or compressing the database.
- In addition, you can simulate the future system size of your system. This is useful for a forecast of the impact any planned measures may cause.

Beside the DVM Work Center, Data Volume Management offers services to give you an overview of your data distribution and quality as well as services to help you to develop a DVM road map for your system landscape. All services allow you to make flexible decision about your content and data volume management.

Additional Information

For more information, see the SAP Help Portal at help.sap.com/solutionmanager SAP Solution Manager <release> Application Help SAP Library Application Operations

For general information about Data Volume Management, see the SAP Community Network at wiki.scn.sap.com/wiki/display/TechOps/Data+Volume+Management.
3.5 Maintenance Planner

Overview

You have to use the Maintenance Planner to do the conversion to SAP S/4HANA 1610. The Maintenance Planner generates the download files (add-ons, packages, DBDs, and the stack configuration file) that the Software Update Manager (SUM) uses to do the conversion. In particular, the Maintenance Planner checks if the following items are supported for the conversion:

- Add-ons to your system
- Active business functions in your system
- Industry solutions

If there is no valid conversion path for any of the items listed above (for example, an add-on is not released for the conversion yet), the Maintenance Planner prevents the conversion. After the check, the Maintenance Planner creates the stack configuration file (stack.xml).

Note

In order to generate the stack.xml, you need to have an SAP S/4HANA license. You can do the above checks without a license, but you cannot create a stack.xml with the Maintenance Planner without a license.

Recommendation

You may run the pre-checks without the stack.xml provided by the Maintenance Planner to get quick and early results, but we strongly recommend that you run the pre-checks again later with the stack.xml because, with this input, the results of the pre-checks will be more accurate and specific to your target product version.

For more information, see the Maintenance Planner User Guide at help.sap.com/maintenanceplanner.

For preparatory steps specific to the conversion to SAP S/4HANA, see also Prepare the Use of the Maintenance Planner [page 20].

Business Functions

Business functions can have the following status: always_on, customer_switchable, and always_off. This results in the following behavior during the conversion:

- If a business function was switched on in the start release system, but defined as always_off in the SAP S/4HANA target release, then a system conversion is not possible with this release.
- If a business function was switched off in the start release system, but defined as always_on in the SAP S/4HANA target release, then the business function will be activated during the conversion.
- If a business function is defined as customer_switchable in the SAP S/4HANA target release, it will keep the state defined in the target release during the conversion.

For more information about always-off and always-on business functions in SAP S/4HANA 1610, see SAP Notes 2240359 and 2240360.
Add-Ons

During the conversion, add-ons are either merged into SAP S/4HANA or deleted if no successor is available. Some add-ons may be included without being fully functional.

For a list of supported add-ons, see SAP Note 2214409. For information about uninstalling add-ons, see SAP Note 2011192.

Industry Solutions

For information about supported industry solutions, see SAP Note 2333141.

3.6 Pre-Checks

SAP supports your conversion project by providing pre-checks that identify some important steps you need to take to ensure your system is compatible with the conversion process.

Note

The pre-checks do not yet identify all the steps needed to perform a conversion. For a full overview, see the Simplification List as explained in Overview of the Conversion Process [page 8]. Perform these checks before starting the Software Update Manager (SUM) in order to have enough time to solve any issues before starting the conversion process.

The results of the pre-check are provided as a list of items you need to address before you can start the conversion process. In addition to the manual pre-check, the checks are run twice again during the conversion process by the Software Update Manager (SUM). The tool stops the conversion if errors persist.

Note

Some of the pre-check reports may take a long time to run.

Prerequisites

You have to run the Maintenance Planner before starting the pre-checks, because the pre-check reports require the stack.xml generated by the Maintenance Planner as an input. For more information, see Maintenance Planner [page 16].

How to Perform Pre-Checks

SAP Note 2182725 and Related Notes

Implement SAP Note 2182725 and all attached related notes. Make sure to use latest version of this note and regularly check for updates of all attached notes. Implement and run these reports on every system in your system landscape (sandbox, development, quality assurance, productive) that you want to convert to S/4HANA.
Report R_S4_PRE_TRANSITION_CHECKS

Run the report R_S4_PRE_TRANSITION_CHECKS in transaction SE38 or SA38 in client 000 of your system. The report checks the data in all clients.

- Perform the report using the option Check Class Consistency Check in case of missing check classes, make sure that you have implemented the latest version of SAP Note 2182725 and related notes and then, if required, open a ticket on the corresponding component for the check class mentioned in the error message. For add-ons, contact the add-on vendor.
- If all check classes exist, run the report with the option S/4 Pre-Trans. Check Results and provide the path to the stack.xml file (that is provided by the Maintenance Planner). You have to copy the file to your ABAP system, for example, to /usr/sap/<SID>/Download. In addition, make sure to activate the simulation mode. You may want to create a variant to make starting subsequent checks easier.

The overall check result return code must be lower or equal to 4. Otherwise the Software Update Manager (SUM) will not be able to perform the conversion of your system. In case of errors, follow the instructions in the messages. The instructions refer to SAP Notes. In this way, resolve all issues until the check report results in a return code lower or equal to 4.

How to Perform Accounting Pre-Checks

Controlling and General Ledger pre-checks are included in the report R_S4_PRE_TRANSITION_CHECKS but the pre-check program for Asset Accounting (FI-AA) is not included in this report. To run pre-checks for Asset Accounting you need to use the report RASFIN_MIGR_PRECHECK and implement the SAP Notes listed in the collective SAP Note 2333236. The report RASFIN_MIGR_PRECHECK needs to be run in each of your productive clients (in contrast to the report R_S4_PRE_TRANSITION_CHECKS which needs to be run only in client 000).

After you have technically converted your system to SAP S/4HANA, you have to migrate your migration-relevant Customizing settings as well as your General Ledger, Asset Accounting, Controlling and Material Ledger data to the new data structure.

For more information about the conversion of Financial Accounting, see SAP Note 2332030.

**Note**

We recommend that you do the conversion to SAP S/4HANA in a development or test system first, so that you get access to the Accounting-relevant Customizing steps. You collect any changes in transport requests which you hand over to the SUM tool when you do your final conversion of your productive system.

For more information, see Conversion in a Distributed System Landscape [page 11].

Pre-Check Messages and Their Meanings

The pre-checks result in green, yellow, or red messages:

- **Green messages**
  These messages indicate that there are no technical or other problems and the conversion can go ahead.

- **Yellow messages**
  These messages provide information about different topics such as changes to Business Functions or adoptions that can be done before or after the conversion. There are no technical problems and the conversion can go ahead. However, some of these yellow messages may be about issues that can cause data loss, even if there is no technical problem affecting the conversion. For instance, per default, no custom table appends are retained during the conversion – the data from those fields is just lost.
Caution
Check yellow messages carefully to keep non-technical conversion issues (such as data loss) from affecting your business processes after the conversion.

- Red messages
These messages always indicate serious issues. Either the conversion will not run because of technical issues, or there are data loss issues where tables have to be deleted manually, or corrections are necessary that can only be done before the conversion.

3.7 Custom Code Migration

The custom code migration checks are based on the simplification item concept. With SAP S/4HANA, business processes have been changed and simplified. Before converting to SAP S/4HANA, you need to check your custom code against the SAP S/4HANA simplifications in a SAP NetWeaver 7.51 system.

The simplifications are loaded into the Custom Code Migration tool. After you run the tool, you get a list of instances where your custom code does not comply with the scope and data structure of SAP S/4HANA.

Note
The custom code checks do not yet identify all the instances where your custom code does not comply with SAP S/4HANA. For a full overview of changes that may affect your custom code, see the Simplification List, as explained in Overview of the Conversion Process [page 8].

Although it is not mandatory, we highly recommend that you perform these checks before starting the conversion process. Otherwise, it is very likely that your custom code will not work correctly after the conversion.

The application content of the simplification database is being increased and improved over time. In addition to the custom code analysis and adaptations based on the Custom Code Migration tool, you also need to test the custom code within SAP S/4HANA.

For additional information about the Custom Code Migration tool, see:
- SAP Note 2241080 for information about how to download the simplification database.

3.8 Cross-Application Preparations

Before starting conversion activities, you need to do the preparatory activities described in the next sections.
3.8.1 Prepare the Use of the Maintenance Planner

Context

Besides the general preparation described in the Maintenance Planner User Guide, you have to make the following preparatory steps specific to the conversion to SAP S/4HANA 1610:

Steps

2. Check the SPAM/SAINT version in your source release system.
   
   Note
   At least SPAM/SAINT patch 59 is required.
3. Apply SAP Note 2186164 to your SAP Solution Manager system.
4. Create an RFC-connection between your source release system and SAP Solution Manager:
   1. In SAP Solution Manager, choose SOLMAN_WORKCENTER Solution Manager Administration Landscape (Technical Systems).
   2. Click RFC connections Start New Window.
   3. Select client 000 and choose Advanced Mode.
   4. Under Export Options, fill in the field SAP Solution Manager Host Name.
   5. Under Communication RFCs, select Create SM_<SID><CLNT><CLNT>_READ.
   7. Enter a password.
   8. Enter a user and password under Managed System Setup Administrator, and choose Test Login in the group Administration Users to check that it works.

More Information

Maintenance Planner [page 16]

3.8.2 Remove Client 066

Context

Client 066 is the Early Watch client which was set up during the installation of your system. This client is not used in SAP S/4HANA. To prevent issues, for example, with job scheduling, you have to remove it before starting the conversion.
Steps

1. To remove client 066, proceed as described in SAP Note 1749142.

3.8.3 Uninstall SAP Fiori Apps

Context

If you have SAP Fiori apps installed locally on your source system, you need to uninstall them if they are not released for USER INTERFACE TECHNOLOGY 7.50 (SAP_UI 7.50). If you do not uninstall these apps, the Maintenance Planer will not allow a conversion for your system.

Note

Use the SAP Fiori Apps Reference Library to check which applications are available for SAP S/4HANA 1610.

Steps

1. Check SAP Note 2034588 for a list of apps that you need to uninstall and the steps required to do so.

   Note

   SAP Note 2200415 provides a list of all apps that are supported by SAP_UI 7.50.

2. Uninstall the apps using SAINT. For more information, see SAP Note 2011192.

3.9 List of Application-Specific Preparations

The list below contains important application-specific preparatory steps and where to find their documentation.

Note

This list contains an overview of important steps, but it is not complete. You find the complete list of conversion-relevant items in the Simplification List, as explained in the overview [page 8].

Table 4: App-Specific Preparations

<table>
<thead>
<tr>
<th>Preparatory Tasks per Application Area</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Governance: Business</td>
<td>SAP Note 2265093</td>
</tr>
<tr>
<td>Partner Approach</td>
<td></td>
</tr>
<tr>
<td>Application Life-Cycle Management:</td>
<td>SAP Note 2216958</td>
</tr>
<tr>
<td>Check Program for Material Number</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Preparatory Tasks per Application Area</td>
<td>Reference</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>Finance</strong></td>
<td>Documentation of Finance-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2332030</td>
</tr>
<tr>
<td><strong>SAP Credit Management</strong></td>
<td>Documentation of all SAP Credit-Management-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2270544</td>
</tr>
<tr>
<td><strong>SAP Cash Management</strong></td>
<td>Cash management</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2270400</td>
</tr>
<tr>
<td><strong>Sales: Order and Contract Management</strong></td>
<td>Foreign Trade Replaced by Global Trade Services</td>
</tr>
<tr>
<td></td>
<td>SAP Notes 2223144 and 2205202</td>
</tr>
<tr>
<td></td>
<td>Revenue Recognition Replaced by SAP Revenue Accounting and Reporting</td>
</tr>
<tr>
<td></td>
<td>SAP Notes 2225170 and 2227824</td>
</tr>
<tr>
<td></td>
<td>Simplified Data Models in Sales and Distribution (SD)</td>
</tr>
<tr>
<td></td>
<td>SAP Notes 2198647 and 2224436</td>
</tr>
<tr>
<td></td>
<td>SD Pricing: Data Model Changes</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2267308</td>
</tr>
<tr>
<td><strong>Retail</strong></td>
<td>Changes in Retail functionality</td>
</tr>
<tr>
<td></td>
<td>SAP Notes 2385984 and 2386003</td>
</tr>
<tr>
<td><strong>Supply Chain: Efficient Logistics and Order Fulfillment</strong></td>
<td>Simplified Data Model in Inventory Management (MM-IM)</td>
</tr>
<tr>
<td></td>
<td>SAP Notes 2206980, 2238690, and 2236753</td>
</tr>
<tr>
<td><strong>Environment Health and Safety</strong></td>
<td>Documentation of all EHS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2336396</td>
</tr>
<tr>
<td><strong>Product Safety and Stewardship</strong></td>
<td>Documentation of all PSS-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2267461</td>
</tr>
<tr>
<td><strong>Discrete Industries &amp; Mill Products</strong></td>
<td>Long material number</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2270396</td>
</tr>
<tr>
<td><strong>Business Network Integration</strong></td>
<td>Conversion from Ariba Network Integration for SAP Business Suite</td>
</tr>
<tr>
<td></td>
<td>SAP Note 2341836</td>
</tr>
</tbody>
</table>
4 Realizing the Conversion

After the preparation phase, you start with the realization of the conversion to SAP S/4HANA 1610 using the Software Update Manager (SUM) tool. For a short overview of the entire process, see Overview of the Conversion Process [page 8].

Note
You find the cross-application follow-on steps in this guide; you get the application-specific follow-on steps with the pre-check and custom-code checks and with the Simplification List for SAP S/4HANA 1610. Some of the most important application-specific preparation steps are also listed in this section: List of Application-Specific Follow-On Activities [page 27].
Please see also SAP Note 2389807.

4.1 Conversion Using SUM

Software Update Manager (SUM) is the technical tool used for the system conversion to SAP S/4HANA.

Note
You have to run the Maintenance Planner before the SUM, because the SUM requires the stack.xml generated by the Maintenance Planner as an input. For more information, see Maintenance Planner [page 16].

Within the SUM-process the following steps are done in a one-step procedure (for dedicated start releases):
1. Database migration (optional).
   If your source system is not yet running on the SAP HANA database, use the database migration option (DMO) of the Software Update Manager to migrate your database to SAP HANA during the conversion.
2. Installation of the SAP S/4HANA 1610 software.
3. Conversion of your data into the new data structure used by SAP S/4HANA 1610 (this is the automated part of the data migration).
For all information about using the SUM, see the guide System Conversion to SAP S/4HANA using SUM 1.0 SP 18 (incl. DMO) available at help.sap.com/sitoolset "Software Logistics Toolset 1.0 (SL Toolset) "System Maintenance "

Please see also SAP Note 2277083 ".

4.2 Cross-Application Follow-On Activities

After the Software Update Manager (SUM) has run, you need to do the follow-on activities described in the next section.

4.2.1 Adapting Database Extensions to SAP S/4HANA

When you convert your system from SAP Suite on HANA to SAP S/4HANA 1610, modifications to the SAP HANA database remain unchanged. However, to make your modifications visible on the UI, manual steps can be required in different content layers.

Procedure

1. If required for your modifications, adapt the relevant Core Data Service (CDS) views in the SAP Business Suite layer. You can extend CDS views by using ABAP development tools. For more information, see help.sap.com/abapdocu_740/en/index.htm "ABAP Keyword Documentation "ABAP Dictionary "ABAP CDS in ABAP Dictionary "ABAP CDS - Views "ABAP CDS - DDL Statements "ABAP CDS - EXTEND VIEW ".

2. If required for your modifications, adapt the OData services for your CDS views in the SAP NetWeaver Gateway layer:
   ○ For OData services that are included in a CDS view definition as an annotation, the relevant artifacts are generated automatically. No modifications are required in the SAP NetWeaver Gateway layer. For more information, see help.sap.com/s4hana_op_1610 "SAP NetWeaver for SAP S/4HANA "Function-Oriented View "Application Server "Application Server ABAP "Application Development on AS ABAP "ABAP Development Tools - Eclipse "SAP ABAP CDS Development User Guide "Exposing CDS view as OData Service ".
   ○ OData services that are not included in a CDS view definition must be redefined in Service Builder. For more information, see help.sap.com/s4hana_op_1610 "SAP NetWeaver for SAP S/4HANA "Function-Oriented View "SAP Gateway Foundation (SAP_GWFND) "SAP Gateway Foundation Developer Guide "SAP Gateway Service Builder "Data Modeling Basics "Data Modeling Options "Redefining Services ".

3. If available for your app, you can use runtime adaptation to add, move, or remove view fields in the UI layer. For more information, see Adapting the User Interface [page 25]. As an alternative, you can extend views by using SAP UI5 extension points. For more information, see help.sap.com/s4hana_op_1610 "SAP NetWeaver for SAP S/4HANA "Function-Oriented View "UI Technologies in SAP NetWeaver "SAPUI5: UI Development Toolkit for HTML5 "Extending Apps "View Extension ".

PUBLIC
© Copyright 2016 SAP SE or an SAP affiliate company.
All rights reserved.
4.2.2 Adapting the User Interface

Key users can adapt the user interface (UI) of their apps at runtime in a modification-free way, for example, by adding, removing, or moving fields and groups. Runtime adaptation is supported for apps that use SmartForm controls with stable IDs. Note that you can only add fields which have been made available for this app. If you need additional fields, you have to create them as described under Creating Custom Fields and Custom Business Logic.

More Information

For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAP Fiori Launchpad ➔ User Guide ➔ Using the Launchpad ➔ Adapting SAP Fiori UIs at Runtime ➔.

4.2.3 Output Management

SAP S/4HANA introduces a new style of output management. Note that other existing frameworks can be used as well, depending on the application.

You make settings for output control in Customizing under Cross-Application Components ➔ Output Control ➔. This is an overview of the required technical setup.

Prerequisites for Output Control

- bgRFC configuration has been set up
- Storage system and category have been maintained
- BRFplus is active and usable
- Adobe Document Services is available (when using Adobe Forms)

bgRFC (Background Remote Function Call)

Output control uses a bgRFC to process output. Therefore, you need to maintain the bgRFC configuration. Otherwise, no output can be performed.

You can perform all the relevant steps in transaction SBGRFCONF. One of the most important steps is defining a supervisor destination, as bgRFC doesn’t work without it.

For more information, enter the keyword bgRFC Configuration at help.sap.com ➔, and refer to SAP Note 2309399 ➔ and SAP Note 1616303 ➔.

Storage System and Category

Output control needs a defined storage system (content repository) to save the rendered form output as PDF.

To set up the storage system, choose the following navigation option:

Table 5

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>➔ SPRO ➔ Cross-Application Components ➔ Document Management ➔ General Data ➔ Settings for Storage Systems ➔ Maintain Storage System ➔</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>/nOAC0</td>
</tr>
</tbody>
</table>
You can set up the storage type which fits your needs, for example a SAP System Database, or a HTTP content server (such as fileserver, database, or external archive).

Once the storage system is available, you need to assign it to the predelivered storage category SOMU. To do so, choose the following navigation option:

Table 6

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components ➔ Document Management ➔ General Data ➔ Settings for Storage Systems ➔ Maintain Storage Category</td>
<td>/nOACT</td>
</tr>
</tbody>
</table>

Select category SOMU. For column Document Area, choose SOMU. For column Content Repository, choose the content repository you created in the previous step.

Business Rule Framework plus (BRFplus)

Output control uses BRFplus for the output parameter determination. Technically, BRFplus is based on WebDynpro applications. Therefore, you need to set up the according ICF services:

Table 7

<table>
<thead>
<tr>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_workbench</td>
<td>FDT Workbench</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_object_manager</td>
<td>FDT Object Manager</td>
</tr>
<tr>
<td>/sap/bc/webdynpro/sap/fdt_wd_catalog_browser</td>
<td>FDT Catalog Browser</td>
</tr>
</tbody>
</table>

For more information, enter the keyword Active Services in SICF at help.sap.com.

Once you’ve set up the services, download and install the required BRFplus applications from SAP Note 2248229.

Procedure:

1. Access transaction BRF+.
   - If required, personalize your screen, and change the user mode from Simple to Expert.
3. On the Business Rule Framework plus – XML Import screen, under File and Transport Request, browse for the local *.xml files you want to import. You can import the files one after the other.
4. In the Customizing Request field, enter an applicable Customizing Request ID.
5. Choose Upload XML File.

Adobe Document Services (ADS)

Applications in SAP S/4HANA ship default form templates implemented as PDF-based print forms with fragments.

They require ADS for rendering. ADS is available as cloud solution or on-premise solution.

The cloud solution is a service provided on the HANA Cloud Platform. See SAP Note 2219598 for more information and links to the documentation for the new solution Form Service by Adobe.

For the on-premise solution, you need an AS Java installation (with ADOBE usage type) to run ADS.

ADS itself must have version 10.4 (1040.xxx) or higher. This version is delivered with NW 7.31 SP7 (and higher), NW 7.40 SP2 (and higher), and NW 7.50 (all SPs).

You do not necessarily need to use ADS, as output management also supports SAPscript and Smart Forms.
However, special customizing is necessary for these two form technologies, and restrictions apply. For more information, see SAP Notes 2292539 and 2294198.

**Printer Setup**

Printing is done using the spool. For more information, see the SAP Printing Guide at the SAP Help portal under help.sap.com/s4hana <choose a release> SAP NetWeaver for SAP S/4HANA Function-Oriented View Solution Life Cycle Management.

Output control uses the short name of the printer (for example LP01), as defined in transaction SPAD.

**Limitations**

- Printing using the spool is not available in release S4CORE 1.00 SP00. If this is the case, please upgrade to S4CORE 1.00 SP01.
- Currently, a PDF is always created for any kind of form. This has the following impact:
  - Previewing the document from the spool request is only possible when the device type is PDF1 or PDFUC.
  - Using another device type can lead to alignment issues for SAPscript and Smart Forms.
- Frontend output is not supported, since the output is processed via bgRFC.

**More Information**

SAP Note 2228611

### 4.3 List of Application-Specific Follow-On Activities

The list below contains important application-specific follow-on steps and where to find their documentation.

**Note**

This list contains an overview of important steps you may need to do after the conversion process, but it is not complete. You find the complete list of conversion-relevant items in the Simplification List, as explained in the overview [page 8].

<table>
<thead>
<tr>
<th>Follow-On Tasks per Application Area</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance</td>
<td>Documentation of Finance-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>SAP Credit Management</td>
<td>Documentation of all SAP Credit Management-related conversion tasks, see the SAP Note.</td>
</tr>
<tr>
<td>Human Resources</td>
<td>Integration of HR Master Data</td>
</tr>
<tr>
<td>Sales: Order and Contract Management</td>
<td>SD Pricing: data model changes</td>
</tr>
<tr>
<td>Follow-On Tasks per Application Area</td>
<td>Reference</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>SD Rebate Processing replacement by Settlement Management</td>
<td>SAP Note 2226380</td>
</tr>
<tr>
<td>Optimization of SD Rebate Processing for Trade Promotion Management</td>
<td>SAP Note 2200691</td>
</tr>
<tr>
<td>Retail</td>
<td></td>
</tr>
<tr>
<td>Cleanup of Retail generic articles and variant data</td>
<td>SAP Note 2350650</td>
</tr>
<tr>
<td>Documentation of site master conversion, see the SAP Note.</td>
<td>SAP Note 2310884</td>
</tr>
<tr>
<td>Environment, Health, and Safety</td>
<td></td>
</tr>
<tr>
<td>Documentation of all EHS-related conversion tasks, see the SAP Note.</td>
<td>SAP Note 2336396</td>
</tr>
<tr>
<td>Product Safety and Stewardship</td>
<td></td>
</tr>
<tr>
<td>Documentation of all PSS-related conversion tasks, see the SAP Note.</td>
<td>SAP Note 2267461</td>
</tr>
<tr>
<td>Integration</td>
<td></td>
</tr>
<tr>
<td>Business network integration: Activities after converting Ariba Network Integration</td>
<td>SAP Note 2341836</td>
</tr>
<tr>
<td>Integration with SAP SuccessFactors Employee Central</td>
<td>SAP Note 2340095</td>
</tr>
</tbody>
</table>
## Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td><img src="Example" alt="Example" /> <img src="Example" alt="Example" /></td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td><a href="http://www.sap.com">www.sap.com</a> <img src="www.sap.com" alt="link" /></td>
<td>Textual cross-references to an internet address</td>
</tr>
<tr>
<td>/example</td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td><img src="123456" alt="123456" /> <img src="123456" alt="link" /></td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456 <img src="123456" alt="link" /></td>
</tr>
</tbody>
</table>

| **Example** | • Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options.  
| | • Cross-references to other documentation or published works |
| **Example** | • Output on the screen following a user action, for example, messages  
| | • Source code or syntax quoted directly from a program  
| | • File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools |
| **EXAMPLE** | Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE |
| **EXAMPLE** | Keys on the keyboard |